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Welcome to StuffIt Standard Edition version 7.0. StuffIt Standard Edition is 
the new name for StuffIt Lite™, and it includes StuffIt Expander™, 
DropStuff™, DropTar™, and DropZip™. 

Version 7.0 of StuffIt Standard Edition includes support for the new StuffIt 
X file format. StuffIt X is a revolutionary new archive file format powered 
by Aladdin's exclusive ATOM compression technology. The new file 
format integrates compression with security and safety options to meet the 
requirements of business and today's digital lifestyle.

StuffIt X includes the following features:

• Better Compression.
• Strong (512bit) Encryption to secure you files.
• Available Error Correction to help prevent archive corruption.
• Support for long file names
• Support for archive sizes beyond 2Gb.

StuffIt Standard Edition requires a Macintosh running Mac OS 8.6 - 9.2.2, 
or Mac OS X 10.1 or later. 

StuffIt Expander 7.0(Mac) or 8.0 (PC) or later is required to expand StuffIt 
X archives. 

While StuffIt Expander is provided free of charge, the other components of 
StuffIt Standard Edition are not. Please feel free to use DropStuff, DropTar, 
and DropZip to see if you like them. If you continue to use one or all of 
them, we encourage you to pay the registration fee. You can purchase 
online simply be clicking the Purchase button that appears in the 
registration dialog when you run the application.

Paying for, and registering, your software entitles you to receive Technical 
Support, and ensures that you will be notified in the event that updates to 
your software become available.

Welcome

What’s New

System 
Requirements

Register your 
Software!

Welcome to StuffIt Standard Edition™
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StuffIt Expander™
StuffIt Expander is used to expand archives, encoded 
files, and other compressed and encoded documents.

StuffIt Expander is easy to use! To expand a file with 
StuffIt Expander, simply drag and drop the file you want 
to expand onto the StuffIt Expander icon. You can also 

expand files with StuffIt Expander by dragging files onto the StuffIt 
Expander application window. You can expand more than one file by 
dragging multiple items onto StuffIt Expander, and you can also expand 
larger groups of files by placing them in a folder and dragging the whole 
folder onto StuffIt Expander.

Note: Even if the Mac OS does not recognize that a file can be 
expanded by StuffIt Expander, you may still be able to expand it. 
Even if the file you want to expand doesn’t have a StuffIt icon, drag 
and drop it onto StuffIt Expander to see if it can be expanded.

While all of the functionality of StuffIt Expander can be accessed using 
Drag and Drop, you can also expand files using commands accessed from 
Expander’s menus.

To Expand using menu commands, choose “Expand” from the File menu 
and select the archive or encoded file you want StuffIt Expander to open.
Overview
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You can change the behavior of StuffIt Expander using the StuffIt 
Expander preferences dialog. To open StuffIt Expander preferences, 
choose Preferences from the “StuffIt Expander” menu in Mac OS X, or 
Preferences from the “Edit” menu in Mac OS 8.6-9.x. 

The Expanding Preferences are used to determine how StuffIt Expander 
goes about the task of expanding an archive or encoded file.

• Expand Archives and Compressed Files: When this prefer-
ence is enabled, StuffIt Expander will expand archives and 
compressed files.

• Delete [archives and encoded files] after expanding: This 
preference is active only when Expand archives and com-
pressed files is enabled. When it is enabled, the archives and 
compressed files you expand will be deleted once the files they 
contain are successfully extracted. Use this preference with cau-
tion!

• Expand Encoded Files: Use this preference to determine 
whether or not StuffIt Expander should attempt to expand 
encoded files.

• Delete [encoded file] after expanding: This preference deter-
mines whether or not encoded files should be deleted after they 
have been expanded. Use this preferences with caution!

• Continue to expand (if possible): This preference, when 
enabled, causes StuffIt Expander to scan the file that results 
from expanding an archive, compressed, or encoded file to see 
if it can be further expanded. For example, when this preference 
is enabled, and StuffIt Expander encounters a BinHex encoded 
StuffIt archive, it will start to expand the archive as soon as it 
has decoded the BinHex layer.

Note: Archives, compressed, and encoded files contained within 
folders in the archive must be separately expanded.

• Ignore Return Receipt messages: Causes StuffIt Expander to 
ignore Return Receipt messages in StuffIt archives.

• Scan for Viruses: StuffIt Expander allows you to automatically 
scan files that are extracted from archives and encoded files for 
viruses with your virus protection software. StuffIt Expander 
supports Virex, Norton Anti-Virus, and Virus Barrier. If you 
would like to try using a different Virus program, choose 
“Other...” from the pop-up menu.

• Open Palm .prc and .pdb files: StuffIt Expander can automat-
ically open Palm application programs in the Palm installation 
program. When this preference is enabled, any Palm application 
StuffIt Expander 
Preferences

Expanding Prefs
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expanded from an archive will be set up for installation in the 
Palm installation program.

• Show Drag window: This preference determines whether or 
not StuffIt Expander’s drag and drop window is displayed.

The joining preferences determine how StuffIt Expander will handle files 
that have been segmented.

• Join Segmented Files: When this preference is enabled, StuffIt 
Expander will attempt to join files that have been segmented 
with StuffIt.

• Delete Segments after joining: When this preference is 
enabled, StuffIt Expander will delete the segments once the 
rejoined file has been saved. Use this preferences with caution.

• Expand joined files (if possible): When this preference is 
enabled, StuffIt Expander will attempt to expand the rejoined 
file if it is a archive, compressed, or encoded file.

Disk Image preferences determines how StuffIt Expander will handle disk 
image files.

• Mount Disk Images: When this preference is enabled, StuffIt 
Expander will attempt to mount disk image files. 

Note: StuffIt Expander is not able to mount .dmg disk image files 
created by Disk Copy under OS X. These disk images must be 
mounted with the Disk Copy application.

• Keep Mounted Images in RAM: When this preference is 
enabled, StuffIt Expander will keep the mounted disk image in 
RAM if there is enough free memory available. A disk image 
mounted in RAM has the same properties as a RAM Disk cre-
ated under classic versions of the Mac OS.

• Mount images unlocked by default: When this preference is 
enabled, StuffIt Expander will attempt to mount disk images as 
unlocked (read/right) volumes.

Note: Images that include compression can only be mounted as 
locked volumes.

The Destination preferences determine where StuffIt Expander will save 
files that have been extracted from archive, compressed, or encoded files.
Joining Prefs

Disk Images 
Prefs

Destination Prefs
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You can choose the location where files are extracted. The following 
options are available:

• Same as Original: When this option is selected, files will be 
saved to the same location as the archive, compressed, or 
encoded file from which they were expanded.

• Ask: When this option is selected, StuffIt Expander will prompt 
you to specify a location to which files should be expanded.

• Use...: Use this option to specify a location to be used every 
time StuffIt Expander saves a file.

You can also specify whether or not StuffIt Expander should place 
expanded files into a new folder.

• When the archive contains multiple items: When this option 
is selected, StuffIt Expander will create a surrounding folder 
whenever the archive contains multiple items at the root level. 
The name of the archive will be used for the newly created 
folder.

• Never: StuffIt Expander will never create a surrounding folder.
• Always: StuffIt Expander will always create a surrounding 

folder.

You can tell StuffIt Expander to monitor and expand files in a particular 
folder, called the “Watch” folder. You can use the Watch Folder feature to 
scan your Internet download folder so that files you download from the 
Internet, regardless of the web browser or utility used, are always 
expanded.

• Check for Files to Expand in: This setting allows you to select 
a target folder for StuffIt Expander to Watch. 

Once StuffIt Expander has scanned the target folder, you can specify what 
happens next:

• Wait...: You can tell StuffIt Expander to stay running and watch 
for new files to expand in a specified number of minutes.

Note: To Stop StuffIt Expander from expanding the same file over 
and over again, you can configure the application to automatically 
delete archives after they have been expanded. Be aware, however, 
that if the archive is damaged and is not expanded, it will have to be 
replaced before you can try expanding it again. Complicated, huh?
Watch Folder 
Prefs
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• Quit: You can tell StuffIt Expander to Quit after files have been 
expanded. 

Note: You will see a “Quit Pending” dialog displayed when StuffIt 
Expander is about to quit. You can use this time to open the prefer-
ences dialog and change the setting so that StuffIt Expander does 
not quit after expanding files.

This preference determines how StuffIt Expander will handle errors that 
occur while files are being expanded.

• Report Errors using alert window: Errors will be displayed in 
an alert window created by the application. Each error must be 
dismissed before the application can continue.

• Ignore errors: Errors will not be reported at all. Expansion will 
continue where possible.

• Log errors to: Errors be logged to a text file.

This preferences determines whether or not StuffIt Expander should check 
for updates and upgrades over the Internet when it is launched.

The Internet Preferences page is used to determine which file types are 
automatically associated with StuffIt Expander by Internet applications 
such as web browsers.

Note: The Internet Preferences panel does not appear when StuffIt 
Expander is running under Mac OS X 10.2. 

If you are exchanging files with a Windows user, StuffIt Expander can help 
to make the files you receive ready for use on your Macintosh. In addition 
to expanding the contents of a zip archive from a PC computer, StuffIt 
Expander will also automatically translate the file extension of a Windows 
file into a Macintosh type and creator code. This means that when you 
double click the file it will open in the correct application (assuming, of 
course, that you have an application able to open the kinds of files you 
expanded.) 

Please!: If you don’t have an application able to open a file you’ve 
expanded with StuffIt Expander, call the person who sent you the 
file not us. Thanks!
Error Reporting 
Prefs
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DropStuff™
This chapter is designed to provide detailed information 
about the StuffIt Drag and Drop applications that are 
included in the StuffIt Deluxe package. These 
applications allow you to perform simple compression 
tasks by dragging and dropping files onto either the 
application window, or the desktop icon. If you are 
looking for basic information about how to create 

archives, and expand archives and encoded files, we recommend that you 
first read the Getting Started chapter before you read this chapter.

DropStuff is used when ever you want to compress files and folders into a 
StuffIt archive. DropStuff can create both StuffIt (.sit) and StuffIt X (.sitx) 
archives, and can create both self-extracting archives, and archives with 
encryption.

Note: DropStuff offers full support for long file names in Mac OS X 
in both the StuffIt (.sit) and StuffIt X (.sitx) archive formats.

To use DropStuff, drag and drop files and/or folders on to either the 
DropStuff icon, or into the new DropStuff application Window. When you 
drag and drop multiple items, those items are combined into a single 
archive file. 

While DropStuff is designed to be used as a drag and drop application, you 
can compress files using the “Stuff” command in the DropStuff File menu. 
When you choose “Stuff” from the File menu, a file selection dialog will be 
used to allow you to select files to compress. Again, if you select multiple 
Overview

Using DropStuff

DropStuff Menus
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files in the selection dialog, they will be combined into a single archive 
file.

DropStuff Preferences can be used to change the compression format used 
by DropStuff when it creates archives, to set the level of compression used, 
and to set advanced options such as making self-expanding and encrypted 
archives.

The “Stuffing” page contains settings that relate to how the application 
creates StuffIt archives.

• Archive Type: DropStuff is able to create StuffIt (.sit) archives, 
or StuffIt X (.sitx) archives. The default archive type is .sit.

• Compression Level: As well as changing the format in which 
the archive will be created, you can also change the compres-
sion level that will be used when items are added to the archive. 
The choices are None, Fast, Med, and Max. An addition level, 
“Optimal” is available when the archive format is set to StuffIt 
X. StuffIt X archives created with Optimal compression will 
take a long time to create, but will be of the smallest possible 
size. When “Optimal” is selected as the compression level, 
DropStuff will choose from all the available compression 
options available under StuffIt X, and choose the best for your 
data.

• Encrypt Archives with a Password: When this option is 
checked, the archives you create will be encrypted with a pass-
word. You will be prompted to provide a password before the 
compression begins.

Note: When you create an archive with encryption, be sure to make 
a careful note of your password. Aladdin cannot recover files from 
encypted archives if you have lost your password. Also note that 
passwords are case sensitive.

• Make Self-Extracting for...: When checked, this preference 
will cause DropStuff to create self-extracting archives. Self-
Extracting archives open automatically without any special 
expansion software. You can choose to create self-extracting 
archives for Mac and Windows.

• Add Error Correction: When this option is selected, the Stuf-
fIt X archive you create will contain error correction code to 
protect them from corruption caused by bad media, or transfer 
errors.
DropStuff 
Preferences

Stuffing Prefs
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The following options effect how DropStuff goes about the job of adding 
files to an archive.

• Delete Originals After Stuffing: The original files that were 
compressed into the archive will be deleted from your hard 
drive when the archive is created.

• Stuff each Item as an individual archive: When this option is 
set, when you drag multiple items onto DropStuff, each item 
will be compressed as an archive. The items will not be com-
bined into a single archive file as they are compressed.

• Don’t Stuff files that are already compressed: File types that 
are known to already include compression (such as Gif images, 
or QuickTime movies) will not be compressed when they are 
added to an archive.

• Ignore Finder Desktop Files: When this option is set, Drop-
Stuff will not add Finder files (such as Desktop Database files 
or .DStore) to an archive.

• Show Drag Window: When this option is set, DropStuff will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the BinHexing page allow you to instruct DropStuff to 
BinHex encode a StuffIt or StuffIt X archive after it has been created. You 
can configure this behavior so that the archive is deleted after it has been 
encoded, and you can also choose to remove the .sit or .sitx from the file 
name; the archive will be named file.hqx, rather than file.sitx.hqx.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, the archive is created in the 
same location as the original files that were compressed. 

• Ask: This option causes DropStuff to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropStuff will be 
saved.

This option allows you to specify whether or not DropStuff should check 
online for updates or newer versions. This preferences is on by default.
Options Prefs

BinHexing Prefs

Destination Prefs

Version Check 
Prefs
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DropTar™
DropTar is a drag and drop application that function in 
much the same way as DropZip and DropStuff, except 
that it creates archives in Tape Archive (.tar) format. 
Drag and Drop files and/or folders onto the DropTar 
icon, or the DropTar application window, to add them to 
a new tar archive. By default, a tape archive does not 
contain any compression. You can have DropTar auto-

matically compress the resulting archive using either Gzip, Bzip, Com-
press, or StuffIt compression.

Note: Tar archives do not contain any form of compression, so 
you’ll find that the Tar archives you create are the same size as the 
original files and folders that were added. DropTar allows you to 
compress a Tar archive after it has been created using either Gzip, 
Bzip, Compress, or StuffIt compression.

Use DropTar in exactly the same way as you would use DropStuff and 
DropZip. Drag and Drop files and/or folders onto the DropTar icon, or the 
DropTar drag and drop window. When you drag and drop multiple items 
onto DropTar they will be combined into a single tape archive.

DropTar Preferences can be used to change the way in which tar archives 
are created, and whether or not they are created with compression.

• Compression Method: Specifies the compression format that 
will be used to compress the newly created .tar archive. Gzip, 
Bzip, Compress, and StuffIt compression is available.

• Compression Level: Specifies the compression level used 
when the archive file is compressed.

• Delete Originals after Archiving: When this option is set, 
DropTar will delete the original files that were added to an 
archive after the archive has been created.

Warning: Use this option with caution!

• Archive each item as an individual archive: When this option 
is set, multiple items dragged onto the DropTar icon, or onto the 
Overview

Using DropTar

DropTar Prefer-
ences

Archiving Prefs
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DropTar application window, will each be added to their own 
individual Tar archive.

• Ignore Finder Desktop Files: When this option is set, DropTar 
will not add Finder files (such as Desktop Database files or 
.DStore) to an archive.

• Show Drag Window: When this option is set, DropTar will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the BinHexing page allow you to instruct DropTar to 
UUEncode a Tar archive, or a compressed tar archive, after it has been 
created. You can configure this behavior so that the archive is deleted after 
it has been encoded, and you can also choose to remove the .tar from the 
file name; the archive will be named file.uu, rather than file.tar.uu.

Macintosh Resource forks are not supported by Zip, Tar, and Lha archives. 
In order to preserve Macintosh Resource fork information it is necessary to 
MacBinary encode these files before they are added to an archive. 

Tip: Just StuffIt! (Use StuffIt X Archives, that is.)

The MacBinary Preferences determines how this MacBinary Encoding is 
preformed.

• Never: Files will never be MacBinary encoded before they are 
added to a tar archive. Macintosh file information will be lost.

• Smart: This means that files that contain extended information 
(such as resource forks) will be encoded before they are 
archived, files that do not contain extended information will not 
be MacBinary encoded before they are added to an archive.

• Always: This option will cause all files added to a tar archive to 
first be MacBinary encoded, regardless of whether they contain 
extended file information.

Note: When you pick a MacBinary option, be aware of who will end 
up using your files. If you use MacBinary encoding and send the 
resulting Tar archive to a UNIX user, they will most likely encounter 
problems when trying to unzip the contents. By default, we assume 
that you are using Tar file because you want to send them to UNIX 
users, and therefore the MacBinary preference is set to Never by 
default. The vast majority of Macintosh files are usable without 
there resource forks, so even if Mac users open Tar archives created 
UUEncoding 
Prefs

MacBinary Prefs
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without MacBinary encoding, they should not encounter a problem 
using the files contained.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, DropTar will create archives in 
the same location as the original files that were compressed. 

• Ask: This option causes DropTar to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropTar will be saved.

This option allows you to specify whether or not DropTar should check 
online for updates or newer versions. This preferences is on by default.
Destination Prefs

Version Check-
ing Prefs
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DropZip™
DropZip is used when ever you want to compress files 
and folders into a Zip archive. DropZip can also be used 
to create Zip files that are encrypted with a password. 
DropZip functions in an almost identical manner to 
DropStuff, except that zip archives are created instead of 
StuffIt Archives. Typically you’ll want to create zip 
archives when you send files to people using PC based 

computers. 

Tip: Zip archives will typically be a little larger that StuffIt or StuffIt 
X archives made from the same data. Before you send zip archives 
to a Windows user, you should first consider sending them StuffIt 
Expander for Windows so that they can open the StuffIt and StuffIt 
X archives you send them. StuffIt Expander can be downloaded for 
free at http://www.stuffit.com

To use DropZip, drag and drop files and/or folders on to either the DropZip 
icon, or into the new DropZip application Window. When you drag and 
drop multiple items, those items are combined into a single archive file. 

While DropZip is designed to be used as a drag and drop application, you 
can compress files using the “Zip” command in the DropZip File menu. 
When you choose “Zip” from the File menu, a file selection dialog will be 
used to allow you to select files to compress. Again, if you select multiple 
files in the selection dialog, they will be combined into a single archive 
file.

DropZip Preferences can be used to change the compression level used 
when creating a zip archive, and can also be used to encrypt zip files with a 
password.

• Compression Level: Sets the compression level that is used 
when creating Zip archives. None, Fast, Med, and Max are the 
available selections.

• Delete Originals after Zipping: When this option is set, 
DropZip will delete the original files that were added to an 
archive after the archive has been created. 
Overview

Using DropZip
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Warning: Use this option with caution!

• Zip each item as an individual archive: When this option is 
set, multiple items dragged onto the DropZip icon or 
application window will be compressed as individual archives, 
rather than combined into a single large archive file.

• Don’t Zip files that are already compressed: When this 
option is set, DropZip will not attempt to compress already 
compressed files (such as .mp3 audio files or .Gif images) 
before it adds them to an archive.

• Encrypt archives with a password: When this option is set, 
DropZip will encrypt the archives it creates with a password. 
You will be prompted to enter the password before items are 
compressed.

Note: When you create an archive with encryption, be sure to make 
a careful note of your password. Aladdin cannot recover files from 
encrypted archives if you have lost your password. Also note that 
passwords are case sensitive.

• Ignore Finder Desktop Files: When this option is set, DropZip 
will not add Finder files (such as Desktop Database files or 
.DStore) to an archive.

• Show Drag Window: When this option is set, DropZip will 
display a drag and drop window when the application runs. You 
can compress files and folders by dragging them onto this win-
dow.

The options in the UUEncoding page allow you to instruct DropZip to 
UUEncode a Zip archive after it has been created. You can configure this 
behavior so that the archive is deleted after it has been encoded, and you 
can also choose to remove the .zip from the file name; the archive will be 
named file.uu, rather than file.tar.uu.

Macintosh Resource forks are not supported by Zip, Tar, and Lha archives. 
In order to preserve Macintosh Resource fork information it is necessary to 
MacBinary encode these files before they are added to an archive. 

Tip: Just StuffIt! (Use StuffIt X archives, that is)

The MacBinary Preferences determines how this MacBinary Encoding is 
preformed.
UUEncoding 
Prefs

MacBinary
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• Never: Files will never be MacBinary encoded before they are 
added to a zip archive. Macintosh file information will be lost.

• Smart: This means that files that contain extended information 
(such as resource forks) will be encoded before they are zipped, 
files that do not contain extended information will not be 
MacBinary Encoded before they are added.

• Always: This option will cause all files added to a zip archive 
to first be MacBinary encoded, regardless of whether they con-
tain extended file information.

Note: When you pick a MacBinary option, be aware of who will end 
up using your files. If you use MacBinary encoding and send the 
resulting Zip archive to a Windows user, they will most likely 
encounter problems when trying to unzip the contents. By default, 
we assume that you are zipping file because you want to send them 
to Windows users, and therefore the MacBinary preference is set to 
Never by default. The vast majority of Macintosh files are usable 
without there resource forks, so even if Mac users open zip archives 
created without MacBinary encoding, they should not encounter a 
problem using the files contained.

The settings in the Destination page where on your hard drive the new 
archive file will be created.

• Same As Original: By default, DropZip will create archives in 
the same location as the original files that were compressed. 

• Ask: This option causes DropZip to prompt you to specify a 
location to which the archive will be saved.

• Use: This option allows you to specify a location on your hard 
drive to which all archives created with DropZip will be saved.

This option allows you to specify whether or not DropZip should check 
online for updates or newer versions. This preferences is on by default.

When you compress files in zip format using DropZip, you’ll notice that 
they are typically smaller than the zip archives created by any other 
application, including PC applications like WinZip. The zip compression 
used by DropZip, and all the other applications in the StuffIt Deluxe 
application, is about 5% more efficient than the zip compression used by 
other applications. Better still, even though DropZip uses an improved 
form of zip compression, the archives you create will still be 100% 
compatible with all the other zip utilities available on the Mac and PC.
Destination Prefs

Version Check-
ing Prefs

Cool DropZip 
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Contact Aladdin
You can contact Aladdin via phone, E-mail, fax, and through the US Mail:

Aladdin Systems, Inc
245 Westridge Drive
Watsonville, CA 95076
USA

Phone: 1+ (831) 761-6200
Fax: 1+ (831) 761-6206 
E-mail: info@aladdinsys.com
Internet: http://www.aladdinsys.com

Aladdin provides technical support via our web site:

http://www.aladdinsys.com/support

Copyright © 2002, Aladdin Systems, Inc. All Rights Reserved. StuffIt, StuffIt Deluxe, StuffIt 
Expander, Expander, DropStuff, DropZip, DropTar, DropConvert, DropSegment, Magic Menu, 
StuffIt Contextual Menu, ArchiveSearch, ArchiveVia Rename, True Finder Integration, StuffIt 
Express, StuffIt Express PE, Express Boxes, Secure Delete, the StuffIt Clamp, StuffIt X, ATOM, 
Private File, and the Aladdin Systems logo are trademarks or registered trademarks of Aladdin 
Systems Inc. All other names, trademarks, and registered trademarks are property of their respective 
holders.

Note: While you may freely distribute StuffIt Expander to friends, and co-workers, you 
may not include Expander as part of any commercial product or service. For information 
on licensing StuffIt Expander for commercial distribution, please contact Aladdin sales.
How to get in 
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Software License Agreement

This is a legal agreement between you and Aladdin Systems, Inc. covering your use of 
StuffIt Deluxe™ and or StuffIt Standard™ (the “Software”). Be sure to read the following 
agreement before using the Software. BY USING THE SOFTWARE (REGARDLESS IF 
YOU HAVE REGISTERED THE SOFTWARE OR NOT), YOU ARE AGREEING TO 
BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO 
THE TERMS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE AND 
DESTROY ALL COPIES IN YOUR POSSESSION.

The Software is owned by Aladdin Systems and is protected by United States copyright 
laws and international treaty provisions. Therefore, you must treat the Software like any 
other copyrighted material (e.g., a book or musical recording). Paying the license fee 
allows you the right to use one copy of the Software on a single computer. You may not 
network the Software or otherwise use it or make it available for use on more than one 
computer at the same time. You may not rent or lease the Software, nor may you modify, 
adapt, translate, reverse engineer, decompile, or disassemble the Software. If you violate 
any part of this agreement, your right to use this Software terminates automatically and 
you must then destroy all copies of the Software in your possession.

The Software and its related documentation are provided “AS IS” and without warranty of 
any kind and Aladdin Systems expressly disclaims all other warranties, expressed or 
implied, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Under no circumstances shall    Aladdin Systems be liable 
for any incidental, special, or consequential damages that result from the use or inability to 
use the Software or related documentation, even if Aladdin Systems has been advised of 
the possibility of such damages. In no event shall Aladdin Systems' liability exceed the 
license fee paid, if any.

This Agreement shall be governed by the laws of the State of California. If for any reason 
a court of competent jurisdiction finds any provision of the Agreement, or portion thereof, 
to be unenforceable, that provision of the Agreement shall be enforced to the maximum 
extent permissible so as to effect the intent of the parties, and the remainder of this 
Agreement shall continue in full force and effect.

The Software and documentation is provided with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the Government is subject to restrictions as set forth in 
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause as 
252.227-7013. Manufacturer is Aladdin Systems, Inc., 245 Westridge Drive,    
Watsonville, California 95076.

Aladdin Systems, Inc., 
245 Westridge Dr., 
Watsonville, California, 95076, 
United States of America

+1 (831) 761-6200 telephone, +1 (831) 761-6206 facsimile.
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